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Version 12.5 Update Supplement 

Installing the New Version of Pulsonix 

It is always recommended you back-up all libraries, designs, technology files, profile files and report 

files before installing the latest version. Other than for any technical reason, this is good working 

practice, although you should already have a backup of this data! 

To install Pulsonix, double-click on the download executable and wait for a short time. You may have 

been supplied a CD, in which case insert it and wait for it to run. The Autorun facility will start the 

installation procedure. Follow the on-screen commands from the install wizard. You can install 

Pulsonix 12.5 over your existing V12.0 installation. If upgrading from V12.0, you can install it 

alongside the older version if you prefer. In any case, you do not need to uninstall the old version first 

unless you wish to remove it from your hard drive. 

64-bit Installation Folder 

By default, Pulsonix V12.5 will be installed into the programs folder C:\Program Files\Pulsonix12.5 

rather than C:\Program Files (X86) which is where the 32-bit applications are installed. 

Documentation Installation 

The default installation locates all Pulsonix ‘documents’ (Master Libraries, Technology files etc.) is 

under user\documents\Pulsonix12.5 rather than being placed in public documents\PulsonixXX 

Licensing 

Version 12.5 requires a new license if you are a new user or upgrading from any older version of 

Pulsonix earlier than and including V12.0. The new license would have been supplied to you under 

the terms of your maintenance contract. 

For existing users upgrading from a previous version, it is recommended that you save the new 

license in the same location as the current one but make a backup copy first or rename it. When 

requested during installation, simply click the No Change In Licensing check box on the licensing 

page of the installation wizard. The License Manager can be used to add new licenses and make 

changes to network licensing after the installation has been completed. 

Version 12.5 Update Notes 

The Version 12.5 Update Notes are available in the Pulsonix product installation folder under 

\documents. Alternatively, select the direct link within the product itself: Help menu | Online 

Manuals> Pulsonix V12.5 Updates Notes. You can also find them on the Pulsonix web site. The set 

of notes on the web site will be more up-to-date than the installed version as we are constantly 

updating these. 

The current and all previous Update Notes are available on the Pulsonix web site under 

Documentation. 
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New In Version 12.5 

Interactive Graphics Enhancement 

An enhancement to the new fast graphics package introduced at V11.0 and V12.0 has been added for 

V12.5 for interactive (dynamic) functions, such as Component Select/Move, Text Select/Move etc. 

There is a new switch in Options, Display called Use for Dynamic Items. When selected, this will 

enable any dynamic item, such as when editing a track or moving a component or text, to be redrawn 

using the enhanced GPU graphics. 

 

Technology Changes 

Export/Import CSV of Additional Rules 

New Export CSV and Import CSV buttons have been added to the Technology dialog for: Spacings 

Design Level, Spacings Net Class Level, Spacings Match Pair Level, Rules High Speed 

Differential Pairs and Nets Signal Paths. 

In addition, the Export CSV and Import CSV buttons have been added in a Panel Design to the 

Technology dialog to the Spacing Design Level Panel tab. 

Existing button on Spacings Net Class Level (Import CSV) has been renamed to Custom CSV 

Import to allow for the new Export/Import CSV functionality. 

Note, the existing Custom CSV option is very specific to particular customer data for import. This 

import allows field customisation. For general CSV import, use the new Import CSV option. There is 

no equivalent Export CSV function for this option. 

Having this functionality allows the additional rules to be exported to a template and then imported to 

create the rules/data once edited. 

This feature was back-fitted to V12.0.8944. 
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Suppressed Land Rules 

Suppressed Lands are now defined by rules, instead of being defined on the layer. Use the new 

Suppress Land Rules page under Technology and Rules DFM/DFT 

 

 

This page offers more flexibility in that a rule can be defined for an Attribute, including Net Names, 

and for Layers and Areas. 

There is also a separate option to override the land suppression when on the Inner Only (not top or 

bottom) layers of the span. 

Suppressed Pads - Additional Drill Spacing 

Within the Technology dialog under Design Level Spacings and the Pad tab, there is an additional 

rule Additional Drill Spacing. This can be used to determine if a pad can be suppressed when 

adjacent to copper on the same net. This spacing is the minimum distance between the drill hole and 

copper on the same net, before the pad will be suppressed. When set, this is used to provide an 

additional spacing (over the drill to copper), before the pad is considered suppressed. 

 

This feature was back-fitted to V12.0. 
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Teardrop Rules by Layer and Area 

Under Technology, Rules DFM/DFT and Teardrops, you can now define Teardrop rules for 

Layers and within a named Area. 

 

Thermal Rules by Layer and Area 

Under Technology, Rules DFM/DFT and Thermal, you can now define Thermal rules for Layers 

and within a named Area. 

 

Unplated Drill to Drill Spacing 

Under Technology, Spacing Rules, Design Level and Drill, an Unplated spacing has been added to 

the Drill To Drill Space rule. This is only applied between unplated drill holes (normal drill spacing 

is applied between plated and unplated holes). In particular, Back Drills are unplated. 
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Changes to Barcode Font 

The Barcode font style has been changed to bring it inline with the font style used for QR codes. 

Previously, the barcode barring and gaps were defined with the font style, as below: 

 

Changes to the dialog mean that you now define the Name, the Font (using <Special Font>) and the 

Special Font Type from the list. You then use the Manage dialog to define the font parameters. 

 

Any existing Barcode font types in your design or Technology file will be converted to this new style 

along with their parameters. 

See below for a full description on using the new functionality. 
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New Font Type for QR Code Generation 

In addition to the existing ability to add a QR code as a bitmap, you can now generate QR codes in 

Pulsonix using a new <Special Font> Font style. The advantage of this over a QR code bitmap is that 

the font can be added to electrical layers whereas a bitmap cannot be. 

When adding a QR code using this new font, the QR code is generated by Pulsonix based on the text 

you enter. 

The QR font must first be defined in the Technology Text Styles dialog using the new  

<Special Font> font style. Then select the Special Font Type to inform it which font to use (Barcode 

or QR Code). 

 

The Manage button is used to define the style of the Barcode or QR Code. 

 

As before, the parameters are the same. 
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The dialog changes for defining a QR Code: 

 

 

QR codes can be used to encode alphanumeric text. Their parameters include: 

Error correction, determines the proportion of codewords in the QR code that can be damaged for the 

QR to still be readable. This will effect the size (version) of the generated QR code. 

Low - 7% 

Medium - 15% 

Quartile - 25% 

High - 30% 

Minimum & Maximum Version The QR standard supports 40 versions based on their size. e.g. 

version 1 QR codes are 21x21, version 2 are 25x25 etc. 
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Boundary Width the width in squares surrounding the QR code. 

Inverted is the QR code inverted. 

Boost Error Correction improves the error correction of the QR code without increasing its version 

(size) if possible. 

Using Special Fonts 

Like existing Barcode fonts, QR fonts can be selected by name once the style name has been defined. 

QR codes work in the same way as Barcodes by using numbers, but also real web site URLs can be 

used such as www.pulsonix.com  

Text Styles Dialog 

If you use a Text Styles dialog, from Properties for example, or anywhere that you can change a text 

style, such as Change Style, you can select the new font <Special Font>.  By selecting it, an 

additional combo box is displayed with preset parameters like Barcode (Interleaved 2 of 5), QR Code 

(ECL: High) etc. 

 

Force Everything Visible in Colours 

Force Everything Visible 

You can now force everything to be visible (Displayed), Selectable or True Width by selecting the 

Force Everything check box in the Colours dialog and Others page. This means you can use one of 

these settings for everything without disturbing any other colour settings you have set. This sets 

everything except Attribute Positions (see below). 
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This switch is available in all editors in Pulsonix, including Schematic, Symbols, PCB, Footprint and 

Panel Editors. 

Force Display Of Attribute Positions 

This check box enables you to force your attribute positions on. This is independent of the Force 

Everything setting in the Colours - Others dialog. 

 

Layers - Allow Micro-via Stop Pad Either Side 

A new check box on inner electrical layers, Allow Micro-via Stop Pad Either Side, allows you to 

create micro-vias onto the electrical layer from above or below, regardless of the facing value of this 

layer. You should only use this if you really know what you’re doing and following consultation with 

your manufacturer. 
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Using this setup enables a layer span like this to be created where a Micro-via can be added as top 

facing but will span to a bottom facing layer. 

 

Spacing Rules – Mounting Hole Spacing Rule Type  

There is now an option to determine if an SMD Mounting Hole is treated as a Mounting Hole or an 

SMD Pad. 

From within Technology, Spacing Rules, Design Level and Pads tab, there is new check box, SMD 

Mounting Hole as SMD Pad. Check this option to cause design rules checking to use the SMD Pad 

spacings for a SMD Mounting Hole (i.e. a mounting hole that is only on one side of the board and 

not drilled). Otherwise, an SMD Mounting Hole uses the spacings for a Mounting Hole. 
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Area Keep In/Out Defined by Rules 

Area Keep In/Out can now be defined by rules within the Technology under Rules, DFM/DFT, 

Area. This in addition to being explicitly defined on an Area. 

The advantage of this mechanism is that you can define one rule that covers many Areas in your 

design, rather than creating individual rules on each Area, such as a named area within a footprint. 

 

Additional new definitions are available for rules: 

Keep Exclusive - the rule defines the matching areas as Keep Out, except for tracks or Vias on 

tracks which originate from a pad in the area. This rule type is only available for Tracks, Vias or 

Micro-vias  

Lift Restrictions - the rule removes any Keep In or Out restrictions defined in Area Properties on 

the matching areas.  

Unrestricted on a rule means no further restrictions (for that type of item). By default, areas have no 

restrictions, which would mean all restrictions are controlled by the rules. 

Area - Keep Exclusive 

For Tracks or Vias, you can define an area as Keep Exclusive. This keeps out Tracks or Vias, 

except for tracks or vias connected with a track which originates from a pad inside the area. 
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Attribute Editor Changes 

Dialog Reorganisation 

The Edit Attribute dialog has been slightly reorganised. The Save Columns button has been 

renamed to Save and the Column Visib button has been renamed to Visibility, and both buttons have 

been moved inside a Column group.  

 

Show Empty Columns 

A new check box has been added inside the Column group named Show Empty. Enabling this 

option will show all empty columns in the grid (provided they are enabled in the Visibility dialog), 

and disabling the option will hide empty columns. 

This was backfitted to V12.0.  

CSV Hidden option 

The Attribute Editor now has an extra check box, CSV Hidden. Check this to have Export CSV to 

include all hidden columns in the output (this is how it worked prior to this option being added) and 

uncheck it to only output columns that are not hidden (this switch is checked by default). 

 

This feature was back-fitted to V12.0. 
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Drag off to create 

a new window 

Attribute Validation using Wildcards 

Matched String is no longer than a specified length 

You can use %l4 (or other number than 4) to ensure that the remainder of the matched string is no 

longer than the number of characters specified (4 in this example). The letter ‘L’ must be lower case. 

Matched String is exactly a specified length 

You can use %L10 (or other number than 10) to ensure that the remainder of the matched string is 

exactly 4 characters long. The letter ‘L’ must be upper case. 

As an example of using this new wildcard, you could define %L10%i|%# which will ensure that the 

remainder of the string (in this case the integer) is exactly 10 characters long. 

Tear-Off Windows 

A new option is available in the Options, Multi-Screen settings that will enable Tear-Off Windows. 

A restart of the program is required to activate it once selected (or deselected). 

 

Tear-off windows are used as an alternative to Multi-screen and are capable of supporting more than 

two screens (unlike Multi-Screen which is only two screens). Once ripped off they can be positioned 

on any screen or along side the main Pulsonix window. You could have a set of schematic sheets in 

one screen and the PCB design in another and cross-probe between them for example. 

Tearing off tabs 

Once activated (in Options, Multi-Screen), tabs can be dragged off the window to create a torn off 

instance of Pulsonix which contains the tab. Simply drag the tab wish to have as another window. An 

additional benefit of this mode is that the exact order and locations of tabs/windows is saved when 

closing and reopening Pulsonix. 

 

This can be done as many times as you want, so long as there is at least one tab in each window. The 

main frame Pulsonix window has toolbars and dock bars available. 
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To reinstate the tabs, simply pick and drag the external window by the tab and release it onto the main 

framework. During this time, the main window will turn blue to indicating the window can be re-

docked: 

 

Once you are using the tear-off screen mode, you’ll notice that the small ‘windows’ icons on the 

framework for Minimise, Full screen and Close are no longer available.  

 

The tear-off windows are sized as required so the only option really required is the Close button. This 

is now available on the workbook tab as an additional X. 

 

Additionally, tabs can be put into groups by dragging a tab to the edge of the screen where the scroll 

bars are located to create a new group. This is useful for putting designs side by side more easily. 

With tabs docked in the main framework, if you right click on a tab, you can create new Horizontal 

and Vertical Tab Groups using the options available 

 



 Pulsonix Version 12.5 Update Notes   21 

 

Make Selected Items Visible in Cross-Probe Mode 

There is a new setting on the Options dialog under Interaction and Cross Probe called Make 

Selected Items Visible.  

 

When this option is checked, any selected items in the design (selected via cross-probe) will attempt 

to become visible and turn on their layer so they can be seen following the probe. The default is for 

this to be enabled (to always make visible). 

With this option unchecked, layers will not be switched on (or redrawn) which is helpful for very 

large designs where one might not want layers toggling after a cross-probe.  

Dynamic Cross-Probe Mode 

There is a new setting on the Options dialog under Interaction and Cross Probe called Online 

Cross Probe. When selected, this will enable automatic Cross Probe while selecting items. All cross-

probing then carried out will be in real time dynamically. 

 

This also works in multi monitor mode and tear-off window mode. 
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Dynamic Cross-Probe Mode – Centre View On Probed Item 

There is a new setting on the Options dialog under Interaction and Cross Probe under Online 

Cross Probe called Centre View On Probed Item. When enabled, selected items from an online 

cross-probe can be centred on the view in the other design to make it obvious where the selected item 

is. 

 

Save/Load Partial Configuration Files 

Underlying Technology 

The underlying technology used to save/load the configuration file has been changed so the 

performance is greatly improved particularly when loading.  

Old Configuration files will still read in but these will not utilise the new, faster mechanism.  

Save Configuration 

On selection of Save Configuration file (from the File menu), this option now displays a dialog 

allowing you to choose between a complete config file (all registry settings) and a partial file 

including only the registry branches relevant to a particular area of the application (folders, 

interaction, UI, etc.). 
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Load Configuration 

On loading a complete config file you are prompted to confirm loading the file, and given the option 

to save a backup file for the current registry configuration before loading the one from the file. The 

loaded file will then replace (rather than “overlay”) the entire PulsonixNN.N registry section. 

Current Document Directory as a Folder 

You can use a dot ‘.’ as the base of a defined folder in any of the Folders dialogs to use the current 

document directory in place of the dot. 

For example: 

.\Libraries 

or simply 

. 

These examples are both valid folders which are dynamically set. 

As a working example, use this in the Libraries STEP Model Folders so that for the current design all 

3D functions will collect the STEP models from the sub folder ‘STEP Models’ of the design folder. 

 

Folders - Include Subfolders 

New Include Subfolders check box in the folders dialog next to the Folder Enabled check box. 

When checked, this option will recursively search through all subfolders of the master folder and add 

any additional files found to the list. This should aid with organisation of libraries and folders. 
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Undo History and dropdown list 

A new menu command has been added to the Edit menu called Undo History. Dropping this down 

will display a list which can be used to undo multiple levels in one action. 

 

The list shows a <Current Position> which is used to more easily identify where in the undo stack you 

are. 

The list can be used to Redo as well by clicking higher up the list after doing an undo. 

3D Space Mouse Support in PCB and SCM Editors 

Support for the 3D Connexion space mouse has been added to Pulsonix designs (in addition to 

existing use within the 3D Viewer window). This will operate once the 3D Space mouse software has 

been installed on your PC. 

It works for the pan functionality in the X and Y axis, and zoom for any native designs including 

Schematics, PCB, PCB Panels, Footprints and Symbols. 

3D Design Changes 

3D Design Menu Changes 

There has been some reorganisation and rationalisation of menu options relating to 3D Design. 

PCB Design Editor 

In the PCB Design Editor, the 3D Design menu has been slightly reorganised to make it more 

logical and follow the order in which menu items are generally used. Also, the Output STL option 

now appears on the 3D Design menu (see below). Other inclusions have been made to add the Board 

3D Origin and Bend Line features. 
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Version 12.0 Version 12.5 

 

 

3D Viewer 

A 3D Design menu has been added to the 3D Viewer to rationalise existing relevant functionality into 

the one menu. 

In the 3D Viewer, the Clash detection options, Fold Boards, Fold Flexi Boards, Align, Orient and 

Rotate have been moved off the Tools menu and have been added to the new 3D Design menu. 

Write STEP file has also been moved from the File menu to the 3D Design menu. 

The Measure option has been moved to the 3D Design menu (previously on the Tools menu). 

The Data Transfer option has been removed from the File menu as it is not required. 

Footprint Editor and PCB Doc Symbol Editor 

The 3D Design menu has been added to both the Footprint Editor and PCB Doc Symbol Editor. 

Menus in these editors contain relevant functionality. 

Dynamic Flexi Board Folding Overview 

Something to note before we discuss this feature is that board bending is not available when using 

Exploded View. If can only be used un-exploded. 

Board Folding Design Preparation 

Below is a summary of the procedures that are required in preparing your design for folding boards. 

More detailed information on this can be found in the Online Help under the Index heading Board 

Bending in 3D Overview. 

Setting up Layers 

You will need to ensure the correct Layers and Layer Span are in your design. An example of a 

simple Flexi-Rigid layer stack is in the ‘4 Layer Flexi-Rigid’ technology include in the Pulsonix 

installation. 
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Inner electrical layers will need to be created for the flexi span, shown below and named as Flexi 

layers (Flexi Top and Flexi Bottom), along with supporting documentation layers if required. 

 

Adding Boards and Board Types 

Create your required boards with the flexi board intersecting other boards so they are connected to 

each other. Change the Layer Span of the flexi board to be on your flexi layer span. For example 

(shown below with the green outlines being board and red as flexi board): 

 

Flexi board folding works by looking at the relationship between board types, and calculates the fold 

and affected transformations dependent on this. Therefore, the board types need to be initially set up 

correctly using Board Properties. There are three board types in Pulsonix: 

Rigid Fixed – a board that is fixed in position and will not be folded or transformed. 

Rigid Moving – a board that will move based on folding flexi boards, but will not folded. 

Flex – a board that will be folded, and can also be transformed based on other folding flexi 

boards. 
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For a flexi board to be folded, it must be attached to a Rigid Fixed board (either directly, or attached 

to a moving board which is attached to a flexi board which is attached to a fixed board etc.), and can 

optionally be attached to one or more Rigid Moving boards. Attaching to multiple Rigid fixed boards 

may produce unexpected results. (Note. By ‘attached’ it is meant that the two boards are intersecting 

in the PCB view). 

To change the Board Type of an inserted board, select the board(s) and click Properties on the 

context menu, and go to the Board tab. 

Adding Bend Lines 

Bend lines are used to define the section of a flexi board that will be folded. A bend line is a single 

segment that cuts through the flexi board, accompanied by two other lines (called the Affected Area) 

offset from the main line. These two lines show the extents of the fold area, and their  position are 

dependent on the Angle and Radius values that are you can define on the bend line. 

To add a bend line, click on a flexi board, right click to open the context menu, and click the Insert 

Bend Line option (this option is not available on rigid fixed and rigid moving boards). To start adding 

the bend line, click outside the board and draw the segment so that it slices through the board, and end 

the segment outside the board. The result should look something like this: 

 

Bend Line Properties 

The bend region is defined using an Angle and Radius. 

The Angle defines the angle at which the bend region will be folded - labelled as theta in the diagram 

below. 

The Radius is defined as the distance away from the bend region that the centre point of the bend is 

located – labelled as r in the diagram below. The radius can be positive or negative, a positive value 

will fold the bend region in the positive Z direction, and a negative value will fold in the negative Z 

direction. 
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Altering the Angle and Radius will change the size of the bend region; which can be seeing visually 

when the offset bend lines move position, or numerically by looking at the Affected Area Width in 

Board Bend Line Properties. This denotes the current width of the bend region. 

After setting up the Bending Angle and Radius, your design should look something like this: 

 

3D Settings for Flexi Board Folding 

There is a Flexi Board Folding section on the 3D Settings Interaction page accessed via the 3D 

Design menu. This defines how the folding will behave and its use of animation. (See the section 

below for more details). 
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Applying the Fold in the 3D Viewer 

Once the boards are set up correctly in the PCB, you can enter the 3D Viewer. 

To perform the fold, use the Fold Flexi Boards option on the 3D Design menu. Using this option 

when flexi boards are already folded will unfold them using the same animation options applied in 3D 

Settings. 

The Fold Flexi Boards option can be used alongside the Fold Board option. 

When folding, if the bend radius is outside of boards, a Folding Clash error will be reported. 

Illegal Items 

Some items are not allowed in bend regions. This will be shown in the 3D Viewer with a Bend 

Region Clash label being shown and the offending objects highlighted in red. If there are clashes, 

that specific fold will not be performed, but all others will be. Items not allowed in bend regions 

include: 

Components 

Boards 

Other items may also not be allowed by your manufacturing process, such as Vias. 

Design Rules Checking 

Design Rules Checking has a new category, Flexi Bend Regions, under the Manufacturing section. 

(see below under Flex Bend Regions DRC for more details. 

3D Flexi Board Folding Settings 

3D Settings Interaction Dialog 

The 3D Settings Interaction page has been reorganised and there is now a Flexi Board Folding 

section. Generating the shapes required for folding flexi boards is done when launching 3D Viewer, 

which can take a long time. The Flexi Board Folding check box allows you to disable (or enable) 

flexi folding which will skip the shape generation and save time (which is useful if you want to 

generate the 3D Viewer but not actually do any folding).  

If disabled, you will not be able to fold. The shapes required to fold are calculated during the initial 

generation of the 3D view, which can take a long time. If it is not required for the user then they can 

disable it to save time. 
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The Show Animation check box lets you toggle whether or not the folding of the flexi board should 

be animated or not. This is used in conjunction with the Animation Precision step slider and lets you 

fine tune how many steps should be in the animation (the more steps, the smoother the animation, but 

it will take longer to generate). 

Animation Precision uses a slider that moves from 1-3. Animation Precision at level 1 will have the 

smallest load time but the animation will be less smooth and at 3 it will have the longest load time but 

smoothest animation. 

3D Settings Settings Additional Settings – Flexi Bend Regions 

A new check box has been added to the Advanced Settings section on the 3D Settings Settings page. 

Enabling Flex Bend Regions will cause the regions to be shown in the 3D Viewer, and disabling the 

check box will hide them. 

 

Changes to Insert Board Origin 

The original Insert Board Origin is now called Insert Board 3D Origin. This option have been 

added to the 3D Design menu.  

This option (using it’s new name) is still available on the context menu when a board is selected. 

This option is still used for annotating plain PCBs on top of each other (that is, non-flexi boards). If 

the board is a flexi, use the Insert Flex Bend Line option instead. The former is a simple quick 

method of transforming boards. 

When using this option, you will only require Board Names and Board Type (to designate the static 

and moving portions of the design). 
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Insert Flex Bend Line 

The is a new Insert Flex Bend Line option. This is used when your design has flexi boards within it. 

It is not used when there are two ‘normal’ boards that which to be transposed, in this instance, you 

will use Insert Board 3D Origin. 

The Insert Flex Bend Line option is available on the context menu when a board is selected. 

The Insert Flex Bend Line option overrides Insert Board 3D Origin if there are placement 

conflicts. Board names are only used for the Insert Board 3D Origin option and are not required for 

Flexi boards. 

Using this option 

You would only have one Rigid Fixed board in the design, all other boards move in relation to this 

one. 

Board outlines in Properties needs to be type, Flex or Rigid Moving and on the correct span layer. 

Flex denotes the actual flexi portion of the board, whereas, Rigid Moving indicates that this board 

will move. 

To move the board, define it as Flex Moving: 

 

The Layer Span for the Shape will be your layer span already defined in the Layer Span page of 

your Technology. 

 

Defining the Flex Bend Line 

When using the Insert Flex Bend Line option (for a selected Board), it must span and reach outside 

of flex board outline. The line must pass the centreline but a warning is issued if it doesn’t meet the 

criteria.  

Self intersecting bend lines are also not allowed and can only intersect 2 area outlines. Multiple bend 

lines are allowed but care must be taken to ensure their Affected Areas do not overlap. 

The image below shows an illegal bend line as it intersects more than two board outline shapes of the 

same board. 
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Bend Line Properties 

The Bend Line Properties dialog for a selected bend line enables you to define the folded boards’ 

angle (Bending Angle) and the curve Radius.  

 

The Bending Angle will be final position as an angle relative to the fixed board. 

The Radius of the bend, (direction + up – down). 

The Affected Area Width is calculated from the Bending Angle and Radius, and is shown in the 

design. Bend lines know where the nearest Fixed board is and do not allow the Affected Area to be 

inside this fixed board. The Affected Area will be the Flex Bend Region once in the design. 

Flex Bend Line Bend Regions 

Once defined, in the design, the flex bend lines show the region that will be affected when the bend is 

applied, this is shown as a translucent region (the same colour as the Bend Line). 
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Copy/paste Bend Lines  

You can also copy and paste Bend Lines. As bend lines require a board to function correctly, you are 

unable to paste a copied bend line if you have nothing currently selected. If you have a bend line 

selected when pasting, it will copy the values of the bend angle and bend radius to the newly pasted 

bend line, and it will be linked to the same board that the currently selected bend line is linked to. If 

you have a board currently selected, pasting a bend line will link the new bend line to that board, but 

will not copy any angle or radius values. 

Bend Regions shown in the 3D Viewer  

Flexi bend regions are visible in the 3D Viewer as seen in the picture below in yellow. The bend 

region is shown as a wireframe outline of the region of the board that will be folded. 

 

The colour is defaulted to yellow, but can be changed on the 3D Settings Colours page, in the Board 

section, by changing the Flexi Bend Regions colour combo. 

 

The bend regions are not output when using the Output STEP file and Output STL options but the 

fold status is (folded or unfolded). 

Comp/Via Keepout Areas in 3D Viewer  

Component and Via Keepout Areas are can now be shown in the 3D Viewer.  

The area shape displayed in the 3D Viewer will be a 2D shape wireframe if the area is on a single 

layer (and without a component height restriction), and if the area is on a span, the area shape will 
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cover that entire span. If the area has a component height restriction, then the area shape height will 

be altered to account for this.  

Below is an example of two areas and a component. The closer area is on layer <Flexi1> with max 

comp height of 0.5mm, and the further area is on layer Flexi-span with max comp height of 1.2mm 

(the height of that component is 1.1mm). 

 

Areas can be enabled/disabled in 3D Settings and the Settings page under Additional Settings 

section, by toggling the Area check box.  

 

An Area colour selection has also been added to 3D Settings Colours page, which has a default 

colour of Dark Red. 

 

Areas are not output when using the Output STEP or Output STL file options. 
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Flex Bend Regions DRC  

Flex Bend Regions DRC 

A Flex Bend Regions check has been added to the Manufacturing section of Design Rules 

Checking. When run, if errors are found, this will report an error code FB. This uses the area that is 

recognised as the Affected Area calculated from the Bend Line and Radius and reported in Board 

Bend Line Properties. 

Running this will check for anything that will cause issues with Flex Board Folding in the 3D 

Viewer, and should be run before using the 3D Viewer.  

 

This DRC check looks for the following potential issues: 

Flex bend lines without a bend region. This could report errrors where the defined Angle or 

Radius is zero, or because the bend region is too large for the section of board where the bend 

line currently is. If this is the case when the 3D Viewer is launched, this bend will be ignored. 

Flex bend regions intersecting with other flex bend regions. Two regions intersecting will 

cause one region to bend but not the other when in the 3D Viewer. 

Flex bend regions intersecting with boards. If the region intersects with a board, then it will 

cause an illegal bend, and so will be ignored. 

Flexi board folding works by folding flexi boards and transforming Rigid Moving 

boards around a single Rigid Fixed board. If another rigid fixed board exists in the 

collection of boards being folded, then it will cause unintended folding (as the fold direction 

is determined by its relative position in comparison to the fixed board). The check will look 

for multiple fixed boards in a collection of boards. 

Flex Bend Region Area Keep Out DRC  

Flex Bend Regions are checked when using the Component Keep Out and Via Keep Out checks in 

DRC. This means that if Components or Vias are inside Flex Bend Regions, an error code will be 

shown (Cm-A for Components, V-A for Vias).  
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These errors are also flagged when using Online DRC, when dropping a Component or Via inside a 

bend region an error message will appear. 

True Folded Board Status used in STEP Output  

Folded boards in their actual fold status (folded and unfolded) are now output when using the Output 

STEP option. This is the case for boards folded using the Fold Boards option on the Tools menu in 

the 3D Viewer, and for folded flexi boards using the Fold Flexi Boards option. 

Changing STEP Colours No Longer Regenerated For 3D Viewer 

When in the 3D Viewer, changing colours and transparency on the 3D Settings Colours page will no 

longer need to regenerate the entire 3D view.  

This is not available when using Exploded View. 

Output STL File 

The Output STL file export has been added to the PCB design 3D Design menu. This will output the 

current PCB into STL format. This is an alternative format instead of STEP for use with MCAD 

systems that support it, such as SolidWorks. It is also one of the most common file formats for 3D 

printers.  This capability allows you to 3D print the populated board as a single item. This could be 

useful for physical visualisation, mockup, and prototyping. 

 

The STL format is a 3D output that only outputs a single shape, and so uses the Single Entity Merge 

functionality to regenerate and merge the entire PCB design into a single shape. Using the Single 

Entity Merge switch means the colour of the STL file is neutral and cannot be changed. The resultant 

file will be in the region of approximately 50% smaller than the file created when outputting to STEP. 

The merged items are then output to the STL file, and then the 3D Viewer will regenerate to show the 

non-merged items. If the single entity merge option is enabled when outputting STL, no regeneration 

is required. 
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Output As A Single Merged Entity 

You can now opt to output STEP as a single entity using the Single Entity Merge check box on the 

3D Settings, Output page. This will also be available when running the 3D Viewer inside Pulsonix. 

Checking the Single Entity Merge check box merges the entire 3D data shapes and components into 

one single entity contained ‘inside’ an assembly so that it can be imported into other software as one 

shape.  

 

The major difference is that the 3D representation of the PCB shown in the 3D Viewer now shows 

the merged shape, which can then be output with a reduced STEP file size. However, as the shape in 

the 3D Viewer is a single entity, interactive options will no longer affect the shape, and all colours 

associated with the shape are removed. The removal of colour is a common feature also found in 

other 3D packages that can export single entity designs, such as FreeCAD. 

By default, the <Design Name> is used for the internal entity but you can also specify your own 

attribute name. Use the Use Attribute Name box if you wish to specifically name the shape output to 

the STEP file. This could be the <Current Variant> attribute for example. 

Using this feature can greatly reduce the loading time in SolidWorks. 
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This feature was back-fitted to V12.0 

Updated 3D Viewer Functionality  

Functionality has been updated in the 3D Viewer, the changes include: 

Zooming 

Zooming in/out using the mouse wheel now zooms towards the position of the cursor. You can still 

use the shortcuts Z and U or the Zoom In and Zoom Out options on the View menu to zoom in and 

out as before. 

Rotation Axis 

When performing camera actions such as rotating and panning, a small ‘+’ will appear at the origin 

point of this camera transformation. This means you can visually see the point at which the camera is 

rotating around. 
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Extended Design Rotation 

As it has been, using the standard right click rotates in an orbit around the centre point of the design, 

(and now also indicated by the new rotation axis, see above). Now you can use Ctrl right click, or 

shift right click which rotates the view centred at your position (as if the camera is your head and you 

are looking around). This enables you extra precision within the positioning movement if you require 

a very specific view to be captures for an image for example. 

Use STEP Model as Enclosure 

A new <STEP Enclosure> attribute has been added which can be added to a component.  

 

If a Component has this attribute (it doesn’t need a value), the STEP model will be added as an 

enclosure in the 3D Viewer instead of being added as a Component/STEP model. This means that if 

enclosures are disabled in the 3D Viewer, these Components/STEP models won’t be displayed. 

When using this attribute, the enclosure colour and transparency will be used for these shapes as they 

are now considered Enclosures. 

When viewing the 3D View Settings dialog and Enclosures page, Components with the STEP 

Enclosure attribute assigned will be shown with the Component name next to each one in square 

brackets. 

 

Improved Performance for Position STEP Model Rotations 

Rotating in the Position STEP Model dialog has been improved so that the view is no longer 

regenerated every time a new rotation is entered into one of the controls. 

Inputting an X, Y or Z value into the controls will generate a new rotation transform, performing the 

rotation in Z first, then Y and finally X. Visually nothing will have changed, but there is a significant 

performance increase, especially on larger models. 
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Interactive Rotating Changes in Position STEP Model 

In the footprint editor and Position STEP Model option, changes have been made to the interactive 

rotating when updating the X, Y and Z controls (using the axis that appears when selecting the STEP 

model). These changes improve the visibility of the model in relation to its initial state (based on how 

it was created) and the footprint it is being positioned on. The new axis now looks like this. Each axis 

movement is coloured and is interactive. It can be selected and moved to adjust the position of the 

model in the preview. The relative coordinates are then reflected in the numerical values in the dialog. 

 

In summary, the changes made are: 

The axis has been moved from the centre of the STEP model to the point that the model is 

being rotated around. 

The axis itself now does not rotate when rotating the STEP model, keeping the X, Y and Z 

axes static. 

Using Undo after interactive rotation now updates the X, Y and Z controls. 

The trihedron axis is now static (it no longer rotates when rotating interactively). 

STEP Model Alignment and Snap by Centre 

When using the STEP Model Alignment feature Snap by Centre option in Design Settings, the 

model can be automatically rotated by 90 degrees in the Z axis to better fit the footprint. If this 

happens, it causes any rotations in the X axis to look like they are being applied to the Y axis, and 

vice versa. The trihedron axis is now rotated to show this. This means that a rotation in the Y will 

rotate about the trihedron’s Y axis, which would be the world space’s X axis. This option has been 

amended because previously, it wasn’t obvious in this instance that the model had been rotated. 

This image shows the model position using Snap By Origin before any positional or rotational 

corrections have been applied: 
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This image shows the model position using Snap By Centre using the same model. You can see that 

the model has been rotated by 90 degrees in the Z axis: 
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New Trihedron Axis View Cube 

In the 3D Viewer and Position STEP Model Preview, the trihedron axis in the lower left corner has 

been replaced with a View Cube (the cube also retains the trihedron axis arrows).  

 

This is also available in the Position STEP Model preview: 

 

The cube will rotate as the camera is rotated, and clicking on a face, edge or vertex of the cube will 

automatically rotate the camera to that orientation. Double clicking on the cube will spin the camera 

so that the board is the correct orientation. 
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The display of the cube is switchable in the 3D Settings dialog under the View tab. From this page, 

you can also define the Position of the cube in the preview window. 

 

Additional Spotlight 

In the 3D Settings and View page, there is a new Use Additional Spotlight option that allows adding 

and defining of a second spotlight. The position of this spotlight is defaulted to {0,0,-100} and will 

light up the bottom of the board, but can be moved using the X, Y and Z controls. Using the Reset 

button will reset the position back to {0,0,-100}. 
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3D Settings – Show Drill Holes for Enabled Items Only 

There is a new check box on 3D Settings on the Settings page named Only Enabled Items. This 

option will allow you to only show drill holes for items that are enabled in the Advanced section. 

 

For example, if you have this option enabled, and you have pads enabled but vias disabled, then drill 

holes will be created in the board shape for pads but not for vias. If you disable this new option then 

all drill holes will be added to the board, as before. 

This was backfitted to V12.0.  

Footprint Moves with Component 

In the 3D Viewer, after moving a Component its footprint will also be moved in the Preview. Note, 

the drill holes will not move without a full redraw. 

Find Bar Changes 

Find Unpoured Templates 

You can now find unpoured templates from the Find bar using a special attribute filter. 

Once Template has been chosen as the find item: 

 

Set the Filter to Attribute where a new special attribute of <Unpoured Template> is available in 

the selection list: 
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You can also set the criteria using the Is: statement and Layer:.  

The results will be displayed for net named templates and templates without a name (shown as <No 

Net>). Unnamed templates will only show one entry for all templates but you can toggle through 

them using the Next and Back arrows at the top of the dialog. 

 

This feature was back-fitted to V12.0. 

Insert Text – Select Text Style 

On the Insert Text dialog there is now an option to select the Text Style before adding text to the 

design. This is not available for text callouts. 

 

Highlight List from Design Selection 

There is a new option on the Find context menu called Highlight List from Design Selection. Once 

selected, this will highlight items in the Find Bar list in context of the selection based on what you 

select in the design. 
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A couple of practical examples of where this may be used are if you were to select some capacitors in 

the design, then in the Find bar, have the find set to Parts. This means that the Find bar would now 

show you all the Part types used for the selected capacitors. This would be good for showing different 

Parts where you might expect to be using the same Parts. 

Another example might be where the Find bar is set to Net and you select a Component in the design. 

The find bar will now show you all the net names attached to that Component. 

Insert Component - Find a Part by Schematic Symbol Name 

From the Insert Component dialog, Find option, you can now match by the schematic symbol 

name using the Sym header. 

 

Parts Library 

Splitters added to Part Editor  

Splitters have been added to Part Editor. These will enable you to control the size of the preview 

windows. 
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Edit Symbol available from Preview window 

From the Parts tab of the Library Manager, on each of the two previews (SCM Symbol and PCB 

Footprint), if you right click over the symbol, from the context menu, you can select Edit Symbol / 

Footprint In Library. If the Part has multiple Schematic Symbols, they will each open in a different 

tab. 

From the context menu in the preview, you can also reset the view of the preview windows using the 

View Extents option. 
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Connector Part – Different Symbol Name on Pins 

When editing a Connector Part in the Parts Library (Pins page), you now have an additional 

column named Symbol. 

Normally, the Symbol name will be the same for every connector pin on the Part. However, you can 

now change the symbol to make one or more pins different, for example, Pin 1. 

 

If you select the Symbol name for the pin you wish to change, you are now presented with the 

Change Symbol button.  

 

This displays the Change Symbol Name dialog which enables you to select the new symbol name. 

 

Once used in the design, changing Pin 1 will look like this: 
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New Pin Types for Ancillary Pads and Mounting Holes 

You can now define Pin Types of Ancillary Pad or Mounting Hole for use within a 

Part/Component. 

When either of these new Pin Types are assign to Pins, they do not contribute to the Part Pin Count.  

These may be useful for defining a pad on a footprint (an Ancillary Pad) that is a ‘belly’ pad for 

example, used for a thermal connection which would not be a normal Pad or a Mounting Hole. You 

may also use this new Pin Type for defining a Schematic pin on a Part that will be connected to with a 

Net and which appears on your Schematic design. 

Ancillary Pad defines a pad which does not contribute to the overall Part Pin Count. In all other 

respects it is a normal Part Pin. It has a pin name, can appear on a schematic symbol, and requires a 

pad in the footprint. As mentioned above, this might be used to define a belly pad for example, used 

on a surface mount device with a thermal connection. 

Mounting Hole defines a pad which does not contribute to the overall Part Pin Count.  

Also, in a PCB design, it is treated like a Mounting Hole for Rule checking purposes. In all other 

respects it is a normal Part Pin. It has a Pin Name, can appear on a Schematic Symbol, and requires a 

pad in the footprint, (the footprint will therefore have more pads than the Part Pin Count). This means 

it can be shown on the Schematic Symbol and design  also, and be connected to with a Net Name. 

Schematic Pin Types 

When editing a Part in the Parts Library (Pins page), you now have two new Pin Types available: 

Mounting Hole or Ancillary Pad. 

 

Using this Pin Type 

Once the Pin Types are defined, they can be assigned to a pin in the Part Editor. 
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The net name can be assigned optionally too as well as the Pin Type. 

Pad Numbers on a Part 

When using the special Pin Types of Ancillary Pin or Mounting Hole, the pad number reported will 

be different to that defined on the  footprint. In this situation, the Pin Count changes and the dialog is 

updated. 

 

The Pad Count changes to reflect the actual number of pads defined. An additional Part Pin  Count 

now displays the count, excluding any pins marked as one of these special types. 
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Pin Types on Pin Properties 

When the Part is used in the design with one of these pins defined, Mounting Hole, in the example 

below, the Pin Type Properties shows its Pin Type as Mounting Hole. 

 

Reload From Library - Match Gates by Pin Names in Schematics 

There is a new option when using Reload From Library in a Schematic design called Match gates 

by pin names.  

This will not normally be used but is available if you have imported a design using one of our import 

filters, such as Allegro, but the gates have been created in a different order from the library. 

 

This option should only be used if you know you have multi-gate parts in the library where the gates 

are in a different order from the part in schematic design. For example, gate “a” in the design is pins 1 

and 2 and gate “c” in the library is pins 1 &2. The reload will swap the gate modifiers so that pin 1 is 

still connected to the same net. 

This was backfitted to V12.0. 
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Check for a Single Signal Refs in ERC in Schematics 

When using the Unfinished Nets check in Electrical Rules Check, it now checks for a single Signal 

References. This means it will check for a second Signal Reference to join to and report an error if 

there is only one Signal Reference on that net. 

 

Unmatched Signal Refs in ERC in Schematics 

Electrical Rules Check has an additional option to find Unmatched Signal Refs. This was 

previously added as part of the Unfinished nets check, but has now been split into a separate option.  

 

Insert Connector Pin - Copy Previous Pin option 

The Insert Connector Pin feature now has an option on the dialog to Copy Previous Pin. 

 

When selected, this copies the orientation and position of attributes from the previous pin on the 

current Component. 
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Change Mounting Hole to Pad 

You can now convert a Mounting Hole to a Pad. This will mainly be used in footprint editing but 

can be used in the PCB Design editor. 

Use this by selecting the Mounting Hole and from the context menu, selecting the Mounting Hole to  

Pad option: 

 

When using this in the footprint editor, the pad will take on the next Pad number in the sequence. 

The pad will still use the same Pad Style but will now be a ‘Pad’ not a Mounting Hole. If the pad (as a 

Mounting hole) used Naming Rules, these rules will still be applied. 

Change a Normal Part to a Connector 

You can now change a normal Part to a Connector. From within the Part Editor, select Change Part 

Type from the Edit menu. 

 

Once selected, this option will remove the Schematic Symbol(s), remove the Gate tab and change 

the Part Type to a Connector. 
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Inspector Bar Changes 

Change Group Order dialog improvements 

The Change Group Order dialog has been changed to use a grid instead of a check-box list for 

displaying group information.  

 

The grid contains four columns: Name, Visible (whether group is shown in the Inspector Bar), 

Height (the height that dialog-based groups should use, for example, Attributes group), and Min 

Height (the minimum height that the group can be resized to).  

Not all Group Name Heights can be edited, but of the ones that can be, multiple group Visible and 

Height values can be changed at the same time. Do this by selecting a range and using the Apply 

Height To Selected Cells option from the context menu to apply a row value to the rest of the rows in 

the range. 

Individual rows or a contiguous range of rows can be selected to allow multiple groups positions to be 

changed at the same time using the Up and Down buttons. 

A Reset Order button has been added, this allows the group order to be reset to the default values. 

A Reset Heights button has been added for a quicker way of resetting all group heights to the 

minimum (default) value. 

Dragging to Create a Group Order 

Dragging a selected row or range of rows using the mouse to another position in the grid can be used 

to change the group order quickly. 

Pre-selection of a Group Row 

Opening the Change Group Order dialog from the context menu after right clicking inside a group in 

the Inspector Bar will pre-select that group row in the grid to help locate it faster. 

Persistent Group Heights 

Group heights are stored in the registry so changes will persist between sessions. 
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Block Groups in PCB Designs  

When a block group is created in the PCB design through either the Translate to PCB or 

Synchronise Design options, the group name will now include the block name in square brackets. 

For example “B1_ [CharacterLeds]”. 

This can be viewed in the PCB design within, Component Properties, Inspector Bar and Find etc. 

 

Like before, these groups are only created for a block instance if the Create PCB Group check box 

is checked in Block Properties. 

When running Synchronise Designs, the report will show you this additional information to be added 

to the PCB design. 

What to do in V12.5 to use this feature 

If you are using these groups in a design that was created in a version previous to V12.5, then be 

aware, you will now need to perform a Synchronise Designs to update the PCB design to change 

these group names to show the additional information. 

If you don’t update the PCB, the integrity will still be correct and match the Schematic but you will 

not see this additional Block Group information. 

Execute Hyperlink in Attributes grid 

In the Attributes group grids, hyperlink enabled attributes can now be executed by right clicking on 

the attribute value column and selecting ‘Execute Hyperlink’ on the context menu. As a visual 

indicator that an attribute value is a hyperlink the text will appear underlined and in a blue link colour. 
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Component Bin Changes 

Show Pre-defined nets on Single Pin Items in the Bin 

If a Component in the Bin has a single pin or pad then it will show the Net Name next to the pin 

name if it has one. Such as a multi-pin connector in Schematics or a testpoint in PCB. 

Once in the Bin, the pre-defined Net Name (but no actual connected net) will be shown prefixed with 

[predef: NetName]. 

 

Highlight Components on Marked Net in Bin  

If you mark a net (using Mark Net) in the design, any components in the bin also attached to that net 

will be highlighted with a small rectangle on the left of the item in the mark net colour. 
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Bin Filtering 

The Component Bin now has a Filter panel. This allows you to just show the components you are 

interested in at a particular time. You can filter by Name, or Component Attribute.  

 

Bin Sorting 

The Component Bin now has a Sort Order panel. This allows you to set up a sort order and set a list 

of attributes to sort the bin by. This is a persistent order that is shared between designs.  

 

Drag Out of Bin Ordering 

When you drag multiple components out of the Component Bin, they are arranged in a horizontal line 

of columns (or a vertical line of rows) of Components. The columns are grouped by component type, 

and they appear in the order that they appear in the component bin.  

New options for sorting and placing items has been added to the context menu. 

You can use Sort by ‘<Component Name>’ in reverse order to toggle the sorting within the 

component Bin. Previously, this was named Toggle Bin Sort Order. 

To adjust the maximum width of the dragged rows (or columns in horizontal mode), right click on the 

Component Bin and then choose Set Drag Out Row Width from the context menu. Type a number 

into the dialog that appears to set the maximum row width (or respective column height). 
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Bus Properties – Report button 

In Schematics, for Properties of a Bus, on the Bus tab, there is now a Report button. This lists the 

name of the Bus, and each net attached to it. 

 

A report will look like something the example below: 

Bus ID[0:7]333: ID[0:7] 

Net Count: 8 

 

  1: ID0 

  2: ID1 

  3: ID2 

  4: ID3 

  5: ID4 

  6: ID5 

  7: ID6 

  8: ID7 

Rename Sub-net in PCB using Change Net 

You can now rename a sub net in PCB when running in safe mode.  

This feature is useful for where a Differential Pair of tracks, for example, have been partially routed 

in and their path is as required but the end pins need to be swapped.  

However, the track path must not contain any additional pads and the tracks must not be routed at 

either ends. Differential Paired tracks with spurs (tracks plus vias) are acceptable though but the 

whole sub-net and spur must be selected. 
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To use this feature, select the first track segment (or track path using Shift-Select). 

Right click and choose Change Net from the context menu: 

 

You are able to select the Change Name Of Sub Net Only option when the track path follows the 

rules. 

You must do this on both track paths to swap, during which, it will temporarily join the two nets. 

Once both have been swapped, Optimise Nets will reorganise the connections and now display them 

as swapped. 
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Auto-Rename - change a Prefix or Suffix 

Auto Rename in both the Schematic and PCB design editors now allows you to add, remove or 

change a prefix or suffix. 

 

You can specify a Prefix or Suffix and you can change these strings From the specified value To a 

different one. 

For example, 'U1_ADD1' with Suffix from '_ADD1' to '_ADD2' would give 'U1_ADD2'. 

When enabled, the Keep Same Numbers switch means only the Prefix and Suffix will be renamed 

and all other names and formatting will be preserved. 

This was backfitted to V12.0.  

Changes to Edit and Add Wire Functionality 

Double clicking on a wire now allows you to edit it so that you can add multiple segments (with 

Mitres and Curves). This works the same as edit shape and can be used for editing a wire to create a 

shape. Previously, only a single segment wire was available; now the wire can be shaped to more 

accurately represent a physical wire that is placed on the manufactured PCB. 
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There are now new arc angle options in Select Mode (when you have a wire segment selected) and on 

the Add Wire context menus to change the angle of the lines’ arc. 

Once the segments have been added, there are additional options on the context menu when a Wire 

corner is selected: 

 

Changes to Apply Vias option 

The Apply Vias options on the Utilities menu has been renamed to Apply Vias/Pads to reflect the 

expanded functionality where it can now include Pads. 

 

When switching to Add Pads, the dialog changes, with Net Name and Vis Span being swapped for 

the pad Layer selection. Pads can only be placed on a named layer and not with a Through-hole 

selection. 

Pads added will be Free Pads on a single electrical layer and will not be on a net, this is useful for 

creating a thieving pattern, for example. These options also work in a footprint design, where 

Component Vias will be added (you cannot add free pads to a footprint). 
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Wire Defaults – Line Angle 

Wire Defaults in Technology, Design Settings, Defaults and Wire now has a new Line Angle 

setting. This lets you set the default arc angle a wire will have when you add it. 

 

Bitmap Scaling Changes 

Large Bitmap Scaling 

Large bitmaps will now be scaled down during import to a size relative to the current zoom level on 

the design. 

Bitmap Scaling From the Context Menu 

Bitmaps can also be scaled from the context menu during the initial placement stage. 

Preserve Attached Segments during edge dragging 

Scaling a bitmap by dragging the edges now uses Preserve Attached Segments when enabled. 

Bitmap Properties 

The Bitmap Properties page Scale box now displays the scale in relation to the original size, and not 

the current size. 
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Mirror Vertically 

There is now a Mirror Vertically command which is available from the context menu in Select 

Mode. The previous Mirror command has been renamed Mirror Horizontally. 

In the illustration below, you can see how the two different mode perform. 

 

 

 

 

 

 

RV1 is the original placement with RV2 Mirrored 

Vertically. 

 

 

 

 

 

 

 

In this example, C1 is the original placement and C2 has 

been Mirrored Horizontally. 

 

Apply layout pattern 

Copy Copper With Template 

A new option, Copy Copper With Template, has been added to the Apply Layout Pattern dialog. 

This is available when applying the pattern from a group. If a template is in this group, then enabling 

the option will now also copy the poured copper associated with it, even if the poured copper is not in 

the group. 
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This feature was back-fitted to V12.0 

Remove Peripheral Items 

The Remove Peripheral Items check box has been added to Apply Layout Pattern. This option is 

only available when applying a pattern to a group.  

When enabled, any peripheral items in the chosen group (Templates, Copper or Text) will be deleted 

before the pattern is applied. This is useful to avoid multiple copies of templates, copper or text when 

a pattern that contains these items is applied. 

 

This was backfitted to V12.0.  
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Cut Shape 

You can now select Cut Shape from the Edit menu. 

This takes a single or multiple selected shape(s) and cuts them with a line, the line thickness can be 

changed. The line can be given a width so that a gap is left between the resulting shapes.  

Cut lines can both open and Closed. When a cutting cut is closed, this can be used for creating a shape 

within a shape; creating shapes that exist as ‘islands’ in a cutout of another shape can be useful for 

creating split power planes. 

The cut line will avoid creating self-intersection shapes dynamically; finding the next best position for 

the end of the line that could potentially be reused elsewhere, for example, in Tracks.  

The Cut Shape option can also cut open shapes (but only one at a time). 

Context menu options 

When setting the cut line, there are other options available on the context menu. 

 

These are standard options but there are two to make note of : 

Closed Shape - Select this option to make the resultant shape closed. This is useful for 

creating a shape within a shape. 

Change Cut Shape Width - Available on all shape types. Use this to set the width of the line 

used to cut the shape, this determines the gap distance between the resulting shapes. If the 

width is set to zero (0), the resultant shapes will overlap on their centre (cut) lines. 

Use Spacing - Available for electrical shapes (Copper, Templates etc.). Select this to use the 

Design Spacing Rule of the item being cut, for example Copper to Copper spacing. This 

spacing will be used instead of the Cut Shape Width. 

The Cut Shape Line Width 

There are three cut line ‘widths’ that can be used (as free widths or Spacings): 

User defined as a shape width, This can be either zero size or a defined size. Zero width aligns the 

centre lines of the resultant shapes coincident on top of each other, or as a width, which creates a gap. 

The gap is also taken between the centre lines. 

When using a Spacing rule width, the gap is taken between the edge of the shapes. 
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Use on Electrical Shapes 

Cut shape also considers when shapes are on a net. When cutting a piece of copper or a template a 

prompt will ask for the net for the new shape to belong to, and this is confirmed after the cut – 

visually showing which shape will be on which net. The option will automatically use the correct 

spacing distance specified in the design rules to determine the gap between cut shapes. If multiple 

shapes are created, you will have an option to set the net of each one in turn. 

After cutting, the option will check for DRC errors and notify you if there are any, with an option to 

undo/cancel the cut. 

Using Cut Shape 

Select the Cut Shape option and select the shape(s) to cut. 

 

Optionally pre-select the shape(s) you wish to cut then select Cut Shape. 

 

Click to start the cutting line, or drag and drop a straight cutting line. 

Continue clicking to add vertices to the line, double-click to finish the line and make the cut. 
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The resulting shapes are left selected, this is ready for another cut if you wish. 

 

Cutting an Electrical Shape 

Add multiple normal shapes that will be converted into cutouts, move them inside the master shape 

and  leave them selected. 

Optionally pre-select the shapes you wish to cut. They must all belong to the same net. 

Choose or type in the name of the net that the new shape will be. 
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Click to start the cutting line, or drag and drop a straight cutting line. 

Continue clicking to add vertices to the line, double-click to finish and make the cut. 

If the cut results in two shapes, you can confirm if the highlighted shape is the correct one to place on 

the new net and choose the other shape if not. 

 

If the cut results in multiple shapes you will be prompted to add each new shape to a net in turn. 
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After cutting, the new shapes will be checked against the design rules, you will be notified if they 

cause an error. 

 

The resultant shapes appear like this: 

 

Improved Wave Shape Generation 

The Wave shape generator has been changed to provide better accuracy at lower Segments Per 

Period settings. 

A result of this change is that the number of Segments Per Period in the wave will now be a multiple 

of 4 (it will be rounded up to the nearest multiple of 4 if not).  
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If the number of segments is exactly 4 it will generate a triangle wave. 

An extra field has been added to show you the Actual Segments Per Period based on the number of 

Segments Per Period typed. 

 

Construction Line Changes 

New Construction Line Shapes 

There are new Construction Line shapes available for Rectangle, Triangle, Polygon, and non-infinite 

lines. These appear on the construction Line menu and are discussed below. 

 

New Non-infinite Construction Line option 

Construction Lines can now be partial and not always infinite, for example, where three lines divide a 

circle. In this instance, the three lines meet in the centre of the circle but the lines extend outside the 

circle to infinity.  
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The other example is where both ends of the line are inside the design area, and neither end is outside 

of this to infinity. 

New Line Options 

The old Line option has been renamed to Infinite Line. 

A new non-infinite Line option has been added to the menu and is called Line. 

 

Change Shape to Construction Line 

The Change Shape Type and Replicate Shape As options can now be used to change a shape to a 

Construction Line. This will convert the shape or line into non-infinite Construction Lines. 

 

This feature was back-fitted to V12.0 but only for circles, splines and ellipses. In V12.5, the full shape 

range is available 

Clip Construction Lines 

Clip Construction Line 

There is a new option available on the Edit menu to Clip Construction Line. This allows you to clip 

any Construction Line using a box, so that the cut shape fits inside the box. This enables you to have 

non-infinite Construction Lines with a region. This declutters your screen if you have many 

Construction Lines defined and also helps you focus on one particular area. 

The default mode uses a box to clip the lines. To clip between two lines select the Clip With Lines 

option on the context menu. 
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Clip with Lines 

While in this mode, using the context menu, you can change to the Clip with Lines option which will 

clip the Construction Line to be between those lines (similar to cut track). This option only works on 

‘open’ Construction Lines.  

 

Using a Box to Clip 

Use two left mouse clicks to define the start and end points of the clip box, or drag the cursor to draw 

the clip box. 

 

The Construction Line(s) will be cut to fit inside the box. 

Between Two Lines 

Use two left mouse clicks to define the start and end points of the first cut line, or drag the cursor to 

define the cut line. 

 

A second dynamic cut line will be displayed at the same angle and length as the first line for you to 

position with your cursor. You can use the Rotate option from the shortcut menu to rotate this line. 

 

Drop the second cut line over the Construction Line(s) to cut them between the two cut lines, or drop 

the second line past the end of Construction Line(s) to cut them from the first cut line to their ends. 
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Note: This option will only work on 'open' Construction Lines. 

Edit Shape Using Construction Lines 

There is a new option for adding regions to or chopping regions out of a selected shape. With the 

shape selected, the option can be accessed from the context menu, Edit Shape Using Construction 

Region. This new mode works with Construction Lines with any sequence of straight or arc 

segments.  

 

 

This means that one Construction Lines are added to and around shapes, the shape can be modified 

based on regions without having to manually select segments, move them and snap to the 

Construction Lines. 

Once the Edit Shape Using Construction Region option is selected from the context menu of a 

selected shape, a selection region indicator is displayed. This will be either a solid shape to indicate 

the shape will be modified outwards, or a dotted region shape to indicate the shape will be modified 

inwards. If the shape can only be modified in one direction, then only the solid indicator is shown. 

Sometimes, regions can’t be selected because they’d cause self-intersecting shapes. 

Below are two examples, showing the two styles of region modification: 

 

Shape modified outwards (region as a solid line): Resultant Shape: 
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Shape Modified Inwards (showing region dotted): Resultant Shape: 

 
 

 

Add Construction Line Along Segment(s) 

With a shape segment or segments selected, from the context menu, you can now add Construction 

Lines along these segments. This will add infinite lines along those selected segments. This option 

means you can quickly add multiple, and often complex, constructions lines to a shape from where 

you can modify the shape using other interactive features, such as Edit Shape Using Construction 

Lines. 

Note, the shape can be curved as well as a straight line segment. 
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Set Tangent Angle 

Using Enter Angle when adding a tangent sets the tangent angle, and finishes at that angle.  

 

This enables you to place a line at an exact tangent angle required. 

 

Snap to Construction Line - Vias 

The option, Snap to Construction Lines has been added to the context menu when moving Vias. 
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Named Construction Lines 

You can now name Construction Lines in their Properties. These names can be made visible by 

ticking the check box. With this, Construction Lines have been added to the Find bar so you can 

locate them. 

 

Divide Circle by an odd number 

You can now use Construction Lines (Infinite Line) to divide circles by an odd number, like 3 or 5, 

this will create semi-infinite lines (infinite in one direction). 
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CAM Plot Changes 

Plot Transformations in CAM Plot Preview 

The Plot Preview page has been changed so that where multiple layers are defined using the Add To 

Plot option, they can be individually transformed in the Preview window. 

Where multiple plots have been defined using the Add To Plot option, the currently selected plot will 

be highlighted in organge. The original plot that the others are based off will be shown in black. 

 

Any transformation performed is given relative to the Plotting Area Registration Point. 

The transformation is given relative to the Plotting Area Registration Point (hence the Shift X & Y 

will be different values to those specified on the CAM Plots page, which give the registration point 

relative to the design origin.) 

The Reset button at the bottom of this dialog is used to cancel any pending edits. 

Fields can be edited to transform the position of individual plots (where more than one has been 

defined using the Add To Plot option). You can edit the Scale, Mirrored, Rotated, Shift X & Shift 

Y values on this dialog. Equivalent values will be set on the original plot where multiple plots are 

defined. 
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The Shift X & Shift Y values can be defined positively or negatively, depending on how you require 

the plot to be shifted on the bed relative to the original plot. 

Splitter Control in CAM Plot Preview 

The Plot Preview page now has a splitter bar. This means the Preview window can be resized to your 

requirements. It also makes the information page resizable to enable you to see more information. 
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Gerber Plot File Extensions 

You can now define the file extension explicitly for a Gerber plot. you can explicitly 

For a Gerber plot, you can now specify an explicit file extension. This will override the default file 

extension for this plot only. Leave this field blank if you want to use the default extension for this 

type of output. This is available from within the CAM Plot option, and Plot Wizard, Process page, 

 

PDF Plot - Zoom on a Clickable Link 

In the CAM Plot dialog, on the Plot Settings, within the PDF Setup dialog, there is now an option 

Zoom On Clickable Link which if disabled will prevent the PDF viewer from zooming into the 

target of a clickable PDF link and instead just do the pan (centre view). An example of a clickable 

link is the Push into Block annotation link. 

 

PDF Plot - Customise Drilled-Out Pad Line Width 

You can now change the stroke width (line width) of drill holes that do not have their pads drawn.  

Previously, drilled-out pads were drawn with single-pixel line which can be very difficult to see on 

the PDF printout. 
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You can now do this by using the PDF Setup dialog and changing the value of the option Drilled-

Out Pad Line Width. You can have an integer value in the range of 0 and 10, where zero is the 

default value. The higher the value the thicker the stroke. 

 

DXF Output – Save settings 

DXF Output now saves all of the selected settings and layers to the registry for Schematic and PCB 

designs. This means that in addition to saving the settings to the registry when outputting a DXF file 

via the Output menu, the settings can also be saved to the design through the CAM Plot mechanism 

where the plot will keep track of the output settings. 

DXF Settings in Configuration Files 

The DXF setting will get saved to the Registry which means it can be transported to another machine 

when saving a Configuration File. Note, these settings are no saved to the Technology but are saved 

into the CAM Plot settings when used, which are therefore saved into the design and Technology file. 

GenCAD Output 

Multi-Threading use for Processing GenCAD Files 

You can now use multiple threads when outputting GenCAD files using either the Output menu or 

the CAM Plots dialog. The vast majority of time spent is in calculating complicated copper shapes 

and so each copper item is calculated in a separate thread. On average, this process is now 66.6% 

faster, with ~76% being the upper end of the speed increase seen. 

GenCAD Settings Saved 

GenCAD plots now support the ability to save the Layers and/or Layer Class Names that are 

selected. 

In the CAM Plot dialog, the GenCAD settings are now saved with the plot setting and hence with the 

design and Technology. 

The GenCAD setting will get saved to the Registry which means it can be transported to another 

machine when saving a Configuration File. Note, these settings are no saved to the Technology but 

are saved into the CAM Plot settings when used, which are therefore saved into the design and 

Technology file. 
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GenCAD Dialog Rearranged 

The GenCAD dialog has been rearranged slightly to more logically group function buttons and for 

new options. 

 

Select Output by Layer or Layer Class 

There are two radio buttons and a check list box on the GenCAD Output dialog allowing you to 

selectively output data by layer or layer class.  

This is to help suppress the output of items like drawing outlines outside the board. This layer only 

applies to shape-based items including doc shapes, copper and tracks, it will not do things like 

suppress layers within pad stacks. 

When switching between Layer Name and Layer Class using the radio buttons, the check box 

updates with the relevant information. 
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Output Board Level Mounting Holes Class 

Two new check boxes allow you to output board (design level) Component (footprint) Mounting 

Holes, Board Mounting Holes, or both (by selecting both check boxes). 

 

Output Current (or Named) Variant 

There are now options to only output the Current (or named) Variant. 

 

Panel Editor 

Interaction Options 

In the Options dialog, Interaction and Panel Interaction, the Create Tab-Rout Around PCB 

Avoids Existing Tab-Routs option had been split into two options.  

Avoid Existing Tab-Routs, this will back off the tab rout so it doesn’t cover an existing tab-rout. 

Back Off by Tab Width, this will back off by the tab width set in the Panel Tab-Rout defaults and 

add mouse bites if they’re enabled. 

With both options off the tab-rout will rout over the existing tab. 

 



 Pulsonix Version 12.5 Update Notes   83 

 

Apply Tab-Rout to All Instances 

When you have a PCB instance selected in the Panel Editor, there is a new Apply Tab-Rout to All 

Instances option available on context menu. This will take the existing tab-rout pattern and copy it to 

all similar PCB instances in the panel. 

 

Double Row Mouse Bites 

You can now add a ‘double’ row of mouse bites when creating tab routs. 

There is a new Double Row setting in the Technology dialog, Design Settings, Defaults and Panel 

Tab-Rout. This will force a double row mouse bites when you add a breakout tab. 

 

 

Doubles row mouse bites will be automatically added when you have two PCB instances adjacent to a 

tab-rout. 
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Hole Centre to Centre Gap 

There is also a new non-editable entry displaying the Hole Centre to Centre Gap. This is a 

calculated value using the Pad Style Drill Diameter plus Hole To Hole Gap value. This is for 

information only and helps you assess the drill hole distance. 

 

Intelligent Gerber Import – New Data Type - Placement CSV 

Within the Intelligent Gerber Import option, Pick and Place CSV data can now be used as an 

alternative to BOM data for adding components to the design. This data type has the added benefit 

over importing a BOM in that it can also intelligently weld them into place the components into the 

design based on their placement positional data.  

This feature will take components from the library using library items already created. The library 

(the footprint specifically) must be orientated to match the original orientation in the Placement file, 

which in turn, represents the same orientation in the design. That means, if the original design had the 

footprint created vertically, then the new Pulsonix must also have the footprint created in this 

orientation. If not, the placement file will orientate/rotate the new component/footprint 90 degrees out 

of position. 

The Part name used in the Pulsonix library must match the Placement file Part name used. 

During import, it will attempt to line up Components with the other imported Gerber data, such as 

pads. Once aligned, it will weld the components into position and delete the original pads underneath. 

 

Once placed and aligned, the components are then welded into place and replace the associated pads 

underneath the component. 
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Generate Component Dialog improvements 

Using the interactive Generate Component option from a selected component in the PCB design, the 

dialog had been reorganised to make it more logical to use. 

 

A check box has been added Save Component To Library which will show the Save To Library 

dialog after the Generate Component dialog closes. 

You can now also edit the values in any of the fields in the dialog to change what the values will be in 

the generated component. If you choose a ref name which is a component in the bin it will replace 

that component with the generated component. 

PDC Database Bar – Splitter Controls Added 

Splitter controls have now been added to the Database bar to adjust the sizes of the search, results 

and preview sections. 

When docked on the left or right the sections will be arranged vertically, and when docked on the top 

or bottom the sections will be arranged horizontally to make the best use of available space. These 

sizes are stored in the registry on program close allowing section sizes to be remembered between 

sessions. 

Splitters are available on the side of the Preview window and above the Results window: 
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When the dialog is resized sufficiently at the right edge, the Preview window will drop to the bottom 

of the dialog. From here, splitters allow the Results and Preview windows to be resized. 

 

Variants 

Doc Shapes 

You can now have Variant Doc Shapes. A doc shape is added to the design and then using 

Properties of the shape, you can define which Variant the shape is fitted in. 

This is a PCB only feature and is not available in Schematics. 

 

Multiple Select Fitted/Not Fitted Components 

You can Fit (or Unfit) multiple components in one hit using the Component Variant Spreadsheet 

from the Edit menu. 

You can do this by using the Ctrl and Shift keys to select the required components in the spreadsheet 

list. 

Once selected, the Variant Details pane changes to a simplified version that only allows the fitted 

status to be changed. 
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Once your changes have been made, either select Update Spreadsheet or Discard Changes to make 

the changes permanent or to discard them. 

This was backfitted to V12.5.9451 

Vault Changes 

Underlying Vault Technology Changes 

For the Version 12.5 release, there have been underlying changes and updates to the following core 

technologies: 

ODBC Driver V13.0 

PostgreSQL server V14.5 

Pulsonix Vault database V12.5 

In order to successfully run the Pulsonix V12.5 Vault, all three technologies should be updated. 
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Updated ODBC Driver 

The V13.0 ODBC driver will be automatically installed during the main Pulsonix product installation. 

The driver is required on the Pulsonix client side. This new driver is required in order to support the 

Postgres server V14.5. 

If, for some reason, the automatic install has not been successful, the driver installer will be available 

in the Vault Admin install folder, normally at “C:\Program Files\Pulsonix Vault Admin 12.5“. The 

file is named psqlodbc_x64.msi and should be run under your system administration permissions. 

Updated Vault Setup ODBC Drivers 

If you run the V12.5 Vault and the old ODBC driver is used (if you have used a previous copy of the 

Vault), this can be changed from with the Vault Setup dialog. 

From the Vault Setup dialog, Sign In page, alter the ODBC driver used to connect to the Vault 

Database using the Change button. You should now be using the V13.0 x64 driver for V12.5. 

 

The Change button will open the Change ODBC driver dialog. From here you can select a Postgres 

ODBC driver from a list of currently installed drivers on your computer. Otherwise, you can press the 

‘Default’ button to select the default Vault ODBC driver. Also, when testing a connection, Pulsonix 

will attempt to use the driver you’ve specified, if it fails, it will automatically attempt to find and use 

an alternative driver. If one is found, you will be prompted that their selection does not work but this 

found working driver will be used. 

Checking the ODBC Drivers 

You can also check the status of the ODBC drivers using the Windows ODBC Driver dialog. 

To access this, from the Windows Start menu, type in ODBC. Select the ODBC Data Sources (64-

bit) application: 
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From the dialog presented, choose the Drivers page. You will see the PostgreSQL ANSI(x64) driver 

listed. 

 

If, for some reason, this hasn’t worked or been successful, the driver installer will be available in the 

Vault Admin setup. You can locate this under the  

C:\Program Files\Pulsonix Vault Admin 12.5 folder. The file is named psqlodbc_x64.msi and should 

be run under your system administration permissions. 
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Updated Vault Postgres Server to V14.5 

The Pulsonix Vault now uses Postgres server version 14.5. The supplied Pulsonix Vault Server Setup 

for V12.5 has been updated to reflect this change and will now install a 64-bit V14.5 Postgres server. 

This new program will be installed when you run the Vault Server Setup program supplied for 

Pulsonix V12.5. 

Existing Pulsonix12.0 Vault Users 

Pulsonix12.0 users that have already been using the Vault with PostgreSQL V9.5 (x86) should still 

run the Pulsonix12.5 Vault Server Setup program to install the 64-bit V14.5 Postgres server 

alongside the V9.5 version. Prior to doing this, the Pulsonix 12.0 Vault Admin program should be 

run, as described below in the “Vault Database Update - Backup your existing Database” section, to 

create a backup of the Pulsonix 12.0 Vault. 

During the PostgreSQL Setup, started by Vault Server Setup, the Port number to be used for 

PostgreSQL V14.5 will be automatically incremented from the one used for the previous PostgreSQL 

V9.5 (e.g. 5432 to 5433). This different Port number will allow Pulsonix to distinguish between the 

two versions of PostgreSQL. 

If so desired, the old PostgreSQL V9.5 (x86) may be removed once the new PostgreSQL V14.5 is 

successfully set up and running the Pulsonix12.5 Vault. Please note that this new incremented port 

number will now be the permanent Postgres port in use by the Vault. 

The Vault Server Setup step 2. Create Vault Database should be performed to create the Pulsonix 

environment in the new PostgreSQL V14.5 server remembering to set the Port number to the 

incremented V14.5 value. The new empty Vault database created now needs to be replaced with the 

Pulsonix 12.0 backup by running the Vault Admin program installed with Pulsonix12.5. This is 

described below in the “Vault Database Update – Restoring the Database” section. 

Pulsonix12.5 should now be launched and the Vault Setup dialog opened. On the Sign In page the 

Server Port should be changed to the incremented V14.5 value and the Test button clicked. If 

successful, the Ok button should be clicked to save the modified Port number. 

The “Vault Database Update” procedure described below should now be performed. 

Vault Database Update 

An updated Vault is used for Pulsonix V12.5 to support the new functionality. 

For new users to the Vault, all the latest V12.5 Vault features and permissions will be included in the 

newly installed Vault database. 

Existing Pulsonix12.0 Vault users need to update your Vault database version to support Pulsonix12.5 

functionality, by following the steps below. 
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Backup your existing Database 

You should first run the Backup tool in the existing Vault Admin program supplied with Pulsonix 

V12.0. 

Use the Vault Admin Backup tool to do this: 

 

Updating the Database 

Using the Vault Server Setup, you should have previously installed the Postgres server (using Step 

1. on the dialog) so that Version 14.x is available. 

During the Vault Server Setup, you should have previously installed and created a new Vault 

database (using Step 2.). Existing Pulsonix12.0 Vault users should have previously transferred the 

Vault database to PostgreSQL V14.x. 

The main Pulsonix V12.5 should have been installed on the client machine. This will have also 

updated the ODBC driver to V13.0.  

For existing Vault 12.0 users, you will need to follow the steps described in the “Vault Database 

Update – Admin Permissions” section and the “Vault Database Update – Updating the Version” 

section. 

Restoring the Database 

When the Pulsonix12.5 Vault Admin program is first run it will still show the Settings from 

Pulsonix12.0. These will need to be changed so the backup is restored for Pulsonix12.5 instead of 

Pulsonix12.0. The Port number will need to be changed to the incremented V14.5 value mentioned 

earlier, and the Postgres Folder will need modifying to use the newly installed 64-bit PostgreSQL 

V14.5, normally, from “C:\Program Files (x86)\PostgreSQL\9.5\bin” to “C:\Program 

Files\PostgreSQL\14\bin”. On the Vault Admin - Restore tab, the Pulsonix12.0 backup should then 

be loaded and the Restore existing option used to restore the Vault database into PostgreSQL V14.5 

ready to be used in Pulsonix12.5. 
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Admin Permissions 

To update the Vault version, the person who is administering the update must have Database 

Maintenance permissions. 

From within the main Pulsonix application, on Vault Setup, the Admin permission under Groups 

must have Database Maintenance permissions set. 

If you are not updating from an existing Vault, the Admin group will already contain the required 

Database Maintenance permission. Otherwise, you will need to create a new group and user, or 

using an existing non-admin group and user, update the permissions of that group to contain 

Database Maintenance. Once the update has been complete, the existing Admin group will be 

automatically updated with the Database Maintenance permission. 
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Updating the Version 

When logged in as a user with the Database Maintenance permission, you will now see the 

Versions tab in the Vault Setup dialog. 

When a Vault format update is available, the Update button will be enabled. You will also get the 

update notification every time you launch the Vault Manager dialog. This notification can be turned 

off in the Warnings page within Options under Prompt Vault Database Updates.  

 

Again, before updating, we highly recommend that you perform a full Vault backup from the Vault 

Admin application. When ready, you can proceed by clicking on the Update button which will 

handle the updating process. 

Confirmation will be shown that this has been successful. The updated Vault is now ready to use. 

Vault Column Sorting 

While using grids within the Vault, you can now sort the columns by right clicking on the columns 

name to sort and selecting Sort Column Ascending or Sort Column Descending from the list. 

 

The sorted column(s) will be highlighted using a small up or down arrow: 
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If more than one column is sorted, the priority will be from the left side move across the columns to 

the right. In the example above, Items first then Actions. 

Once columns have been sorted, right clicking again displays an addition command to Clear All 

Column Sorting. This restores the columns to their original settings. 

 

Sign Out from Vault 

In the Vault Setup dialog, there is a new Sign Out button within the Sign In page.  

When you press Sign Out, your primary and secondary login details will be erased and you will be 

disconnected from the Vault. In order to continue to use Vault features, you will need to sign back in 

again. 

 

Changing Vault Column Order 

While using grids within the Vault, you can now move and reorder the columns by selecting the cell 

name and dragging it into the required position. 

During the move, the new position will be highlighted with two small red markers: 

 



 Pulsonix Version 12.5 Update Notes   95 

 

If you wish to reset the columns to their original location, right click on the column header and select 

Reset Column Order from the menu: 

 

Splitter Controls in Browser Window 

Splitter controls have now been added to the Browser page in Vault Manager to adjust the sizes of 

the items grid, details grid, design previews and attributes list. These are indicated when you hover 

your cursor over the double 'splitter' lines. These sizes are saved to the registry when the page is 

closed and loaded when it is opened. 

 

‘Generic’ Files with Vault  

You can now check in and out ‘generic’ files with the Vault. The files can be of any non-Pulsonix 

data type such as PDF, Gerber, NC Drill, BOMS, Excel/Word documents etc.  

Using the new Generic Files to Vault page in the Vault Manager dialog, you are able to browse for 

file(s) and check them in. Whilst adding files, you will be prompt to associate the file(s) with an 

existing vault design. As these files are a non-Pulsonix type, each file must have a unique name (no 
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duplicates allowed). However, you can over come this by associated the file to an existing design 

whereby the name of the file will be unique to that design (you can have multiple files of the same 

name as long as they are associated with different designs). 

There is an additional tab on the dialog for Generic Files to Vault: 

 

Transfer Library Data to Vault – New Data Types 

You can now transfer 3D Packages and STEP Models as well as existing library types: 
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Find Components by Footprint or Symbol in Vault Speed-up 

In the main Pulsonix Library Manager on the Parts page containing libraries from the Vault, if you 

use the Find option and search for all Parts containing a footprint and/or a symbol name matching a 

specified string, a significant speed-up has been implemented. This new speed-up turns previous 

search times of an average 2 mins (one reported as 30mins) to mere 1 second.  

Note that this speedup is only relevant if you have a Vault that has cross-referencing enabled in the 

Vault Setup Options page. 

Show Attributes from Vault Browser 

From the Vault Browser dialog, there is a new context menu option (when you right click on a 

selection of parts or footprints from the items grid) called Show Attributes.  

 

When selected, this will open the Attribute Editor dialog (in read-only mode) which allows you to 

view the attributes of the selected items. This works the same method as the Attributes button from 

the main Library Manager on the Parts or Footprints page. 
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Filter Capability Added to the Check Out from Vault Dialog 

The Check Out from Vault dialog (access via Check Out or Copy Out command in Vault toolbar) 

now allows you to Filter the names of items within the vault using names ad wildcards.  

 

Execute Attribute Hyperlink 

You can now execute hyperlinks from the Attribute list in the Vault Browser dialog.  

To do this, select a Part or Symbol in the Vault Browser dialog, if the item has attributes, the 

attributes list (bottom right) will fill. If you double-click an attribute defined as a hyperlink (marked 

in blue), it will open the hyperlink. Alternatively, if you select the attribute and right-click anywhere 

within the attributes list, it will give you a context menu with the command Execute Hyperlink 

which will open it as well. 
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Check-Out / Copy-Out Vault item using the Vault Toolbar Preselects The Item 

With a Design, Symbol or Part editor open, using the Check Out or Copy Out commands from the 

Vault toolbar, will now open the Check Out / Copy Out dialog and preselect the currently opened 

Design, Symbol or Part if it is present in the Vault. The open item has to have been checked into the 

Vault previously and have a Vault ID. 

 

Import Libraries to Vault 

The existing Export Vault Libraries feature allows Pulsonix library items to be exported from the 

Vault, usually, to facilitate improved performance when working remotely. The new Import Vault 

Libraries feature allows modifications made to those library items while held in an exported local 

library to be re-introduced (imported) to the Vault in a single operation rather than individually 

checking in each changed item (both Import and Export are licensed options and will usually be 

paired). 

A new Import Vault Libraries page has been added to the Vault Manager dialog.  
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Special Note 

Note: Not importing a full set of changes may mean reloads later. Any modified library items, 

referencing or referenced by other library items e.g. Footprint or Symbols, not imported at the same 

time will have to subsequently reload those referenced items before they will be able to be checked 

into the Vault. 

Using this dialog 

From this page, you can browse to the directory that you exported you Vault libraries to, and 

reintroduce them back into the Vault.  

This mechanism will go through the given directory and import any library items that have been 

changed locally, when compared to the Vault version. Additionally, with the correct settings enabled, 

it can also add any new library items that were created locally. You can also check to see what 

changes will be made and any potential errors found by pressing the Check button. 

PLM Command File Interface for the new Import Vault Libraries option  

There is a new command available in the PLM interface to the Command File Interface called 

VaultImport. This enables the new function in the Vault, (Import Vault Libraries), to be 

performed through a command line interface. 

Optional parameters allows for the override of the options specified from within Pulsonix. By running 

Pulsonix from the command line with a Pulsonix Command File as a parameter, the Vault Library 

Import facility can be utilised from the Windows Scheduler to create a regular reoccurring task. The 

full recommended command line is shown below: 

 

Pulsonix.exe -hidden -commandfile <path to command file> 

 

The PLM interface is only available if you have purchased the PLM option. 

Vault Attribute Colours 

From the Vault Setup dialog under the Colours page, there is a new section of controls, that allows 

you to create Attribute Colour Rules. 

 

These rules are created by first selecting a Pulsonix data type from the drop down (Part in the above 

example), then selecting an attribute from the in-cell combo box (the attribute must first be associated 

with the Vault and that data type. Do this from the Vault Attributes Page). Then define an attribute 

value for which you want the colours to be applied when the item attribute value is equal to this value.  

Finally, you can then set the Text colour and Background colour associated with this new rule.  The 

Example box displays how the rule will look when satisfied. When applied, these colour rules will be 

seen in the Vault Browser page where items that have attribute values that match the defined rules 

will have their grid row painted with the colours chosen. 
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Library ToolKit Changes 

The Library Toolkit feature has been updated with the following changes: 

Parts Files (.pgf) 

Format 4 in PGF files is now the current format to support the following commands: 

Several new commands have been added for PGF files: 

ADDASSOCPART 

SCMPART 

REPLACEFOOTPRINT 

REPLACESYMBOL 

Some commands have been renamed: 

Old NEWPART command has been changed to PART 

Old PART command has been changed to PCBPART 

The CONNECTOR command has been changed: 

ADDGATE will no longer add gates to a part which are created with CONNECTOR enabled. 

You should still use the PART command to create connector parts. As this was the 

previously named NEWPART command so the SCMSYM field must now be empty in order to make 

the part a Connector. If SCMSYM field is not blank, the part will not be a Connector and will use the 

given symbol instead. 

More information can be found in the Library Toolkit Users Guide on the Pulsonix web site. 

Report Maker Changes 

Change Command Colour and Font / Size 

In Report Maker, you now has the ability to change the Font and Font Size, and the Colour of the 

text in the Format Script section (the report script itself). A new Options button is available from the 

main Report Maker dialog: 
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Change Font 

You can change the Font using the combo box. The default font used is listed as DEFAULT. 

Change Font Size using the slider. This will adjust the pixel size. The default is 8. Generally 

speaking, it is expected that a larger font size will be required due to screen resolution of say, 4K 

monitors. 

Change Command Colours 

In Report Maker, you now has the ability to change the text colour of commands in the Format 

Script section (the report script itself), use the new Options button. 

 

In the grid at the bottom of the dialog, is a list of different command types. For each command type, 

you can change the Colour in which you would like the text to be. 

Use the Enabled check box on the same row to force this new colour selection. If disabled 

(unchecked) the default colour will be used. 

There are two sets of colours for each command type, one for dark mode and the other for light. 

These colours can be edited depending on which mode your application is currently set to. For 

example, you can only change dark mode colours whilst the application is using the dark theme. 



 Pulsonix Version 12.5 Update Notes   103 

 

 

New command - Symbol Library Path / Name 

In Report Maker, you can now report Current Library Path and Name when doing List Of Parts 

(uses default footprint), List Of Part Gates, List Of Symbol Names and List Of Footprint Names 

when running from a Parts Library. 

 

This feature was back-fitted to V12.0 

New command - Output to Excel V12.0 

A new command has been added to allow the creation of Excel format reports. 

The new Excel command defines the report to be written in and saved as a native binary .xlsx file, 

(not CSV format). 
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This feature was back-fitted to V12.0. 

Network License Server Manager 

Disconnect All Clients  

From the Disconnect Clients dialog within the Network License Server Manager (NLSM) there is 

a new button named Disconnect All. When selected, it will disconnect all users currently connected. 

This is a easy alternative to selecting individual users and clicking Disconnect. 

 

Disconnect All Clients via Configuration File 

A new command can be used in the network licensing configuration file - DisconnectAllClients. 

When defined with a value between 0 and 2400, the server will automatically disconnect all 

connected clients at the time defined. For example, adding DisconnectAllClients 1930 to the 

configuration file will tell the server to automatically send the disconnect all clients message at 

19:30PM. To disable this feature, remove the command from the configuration file or set the time to 

be 2400.  

You can edit the configuration file by opening NLSM and going to Configuration File… and 

clicking on the Edit button. If the server is currently running, you will need to press the Reload button 

to ask the server to reload the new changes in the configuration file. 

Scripting Changes 

Import/Export Library Items 

New functions have been added to scripting that allow importing a Part/symbol into a library, and 

exporting a Part/symbol from a library. The functions added are: 

PartLibrary – Import (Write a part to the library using the file path of the part) 

SymbolLibrary – Import (Write a symbol to the library using the file path of the symbol). 



 Pulsonix Version 12.5 Update Notes   105 

 

Part – Export (Export the part to the specified directory). 

PulsonixDocument – ExportLibraryItem (Export the library item to the specified directory).  

Note: Symbols in a library are currently classed as PulsonixDocument’s in scripting, not 

symbols. 

This feature was back-fitted to V12.0.  

New AddFootprintFromLibrary and AddFootprintFromLibrary Methods 

New AddGateFromLibrary and AddFootprintFromLibrary methods on a Part object have been 

added.  

Each function is on a Part and it is used to add a Gate or Footprint to the Part from a symbol library. 

This works in a similar way to how the Insert Gate option works in the Parts editor. 

The function tries to find the symbol in the given library and adds it as a gate or footprint to the Part. 

It requires the symbol/footprint name and the library name, and if the symbol/footprint is found in the 

library, it will be added to the Part. 

This has been backfitted to 12.0.  

Differential Pair Chains and Signal Paths 

You can now access Differential Pair Chains and Signal Paths through scripting. The following 

objects have been added: 

DiffPairChain – Represents a diff pair chain and allows access to its name, start pads, end 

pads, a list of all diff pairs in the chain and the maximum length difference and minimum 

percent paired rule values. 

DiffPairChains – A list of all diff pair chains. 

SignalPath – Represents a signal path and allows access to its name, start pad, end pad and a 

list of all the pads in the signal path. 

SignalPaths – A list of all signal paths 

The function IsInChain has also been added to a DiffPair object to check whether the diff pair is 

currently part of a chain. 

This feature was back-fitted to V12.0.  

Scripting Part for AddGate and Library Close Methods 

A new AddGate method on a Part object has been added. It requires the path of a Schematic Symbol, 

and will add that symbol as a Gate for the Part.  

Also added is a new Close method for Part and Symbol Libraries. This allows the library to be 

manually closed (this was needed as opening a library increments the document count, and he needed 

it closed to decrement the document count). 

This has been backfitted to 12.0.  

New Script Added - Out_of_data_vault_parts_in_designs.vbs 

A new script has been added to the Scripts\Examples folder called 

Out_of_data_vault_parts_in_designs.vbs. When run, the script will search for all PCB or SCM 
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designs within the given directory and sub-directories. For each design that it discovers, it will run the 

given report on the design (to be used with Out of Date Vault Items) report. The results from these 

reports will be appended to a single file that is created in the same folder as the script. Once finished, 

this file will contain the list of Parts from all designs that are not the most up to date revision when 

compared to the currently connected Vault.  

There is a section in the Report Maker - Vault Commands help page that discusses how to use the 

script. 

Progress Indicator on Taskbar Icon 

The current state of any progress bar is now displayed on the taskbar icon for Pulsonix. This means 

the progress can be seen even when Pulsonix is minimised. This is particularly useful if long longs are 

being performed, such as a DRC on a very large design. 

The Pulsonix icon will show a green slider moving across as the option progresses. 

 

Dynamic Design Verify Improvements 

Enable Dynamic Verify 

When instructed by your local service office, Dynamic Verify is now performed in a different thread 

so that it has little to no impact on normal usage of Pulsonix. This means it is much more practical to 

have all checks enabled so that the design is verified constantly while changes are being made. 

This option is enabled from the File menu, Document Properties and Statistics page and using the 

Enable Dynamic Verify button. 

 

New options enable Verify Design on Save, which when selected, is used for verifying the design 

whenever a save is performed (note: this is only Save and not on a Save As). On large designs this 

can significantly slow down saving if verifying takes a while. Use the Use Dynamic Verify Settings 
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switch to only check for the Dynamic Verify faults instead of every fault if you wish. This can help 

speed it up. 

Within the Enable Dynamic Verify dialog, there is a button to quickly Enable All checks and a 

button to Verify the design with the currently enabled checks. On large designs this can significantly 

slow down saving if verifying takes a while. There is another switch to only check for the Dynamic 

Verify faults instead of every fault if you wish; this can speed things. 

 

When running on larger designs, a progress bar to show how far the verify has progressed is 

displayed. A message to show the current signature of the design is also displayed. 

 

A report is produced once completed showing you any errors: 

 

A small icon on the right side of the status bar will display the current status of the Dynamic Verify 

once enabled. 
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A green tick shows the design is free of signature errors. 

 

A red exclamation mark indicates the presence of errors, and a spinning circle is used when the design 

is currently being verified in the background. 

 

This icon can also be double-clicked to display the Dynamic Verify Dialog. 

 

Designs now store their last signature result which can be checked when opening the design and can 

be used to tell if the signature error has suddenly got worse (or better!) 

Memory Dumps 

Under certain extreme circumstances, if you encounter the ‘Pulsonix has encountered an error’ 

window, this now has an option to save a memory dump of the error to a temporary location on your 

local machine. The dump file (.dmp) can be sent along with an up-to-date support file (which is 

generated at the same time in the same folder) to Pulsonix support to help them find the cause of the 

error and fix it. 

Depending on the design size and complexity, this process can take some time to create the dump. 

This could be in the hours if the design is very large, so be aware. Once complete, a window will 

appear to tell you where the file was saved to. 

This was backfitted to V12.0. 

 


